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Chief Architect X16 Migration Guide - What's New in Chief Architect X16

What’s New in Chief Architect X16

Welcome to Chief Architect X16. This topic has been written to help our upgrading customers make a smooth transition
from earlier versions of Chief Architect to Chief Architect X16.
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Getting Started Checklist

There are many new features in Chief Architect X16, and many existing features have changed. The following list suggests
steps you should take before migrating your files to Chief Architect X16. More information about each of these steps can be
found after the list.

[ 1. Review the List of New and Improved Features by Chapter

There are a number of important reasons why you should familiarize yourself with the new and improved features in
Chief Architect X16:

e New and improved features allow you to produce drawings more efficiently, so it is to your advantage to use
them.

¢ Some changes to existing functionality may affect your accustomed drawing style and thus your productivity
if you are not aware of them.

¢ New features may affect your choice of settings in your template files, as well as your preferred Preferences
settings.

See New and Improved Features by Chapter on page 13.

[ 2. Review Migrating Legacy Content
Legacy users of Chief Architect often have library catalogs and other custom content that they want to continue using.
See Migrating Legacy Content on page 4.

[ 3. Review Migrating Legacy Settings
Before migrating Preferences, Toolbars, or Hotkeys, bear in mind that legacy settings may not be best suited for using
the new program version. See Migrating Legacy Settings on page 4.

[] 4. Review Migrating Legacy Templates

Before migrating Templates, bear in mind that they may not be set up to take advantage of new tools in the new
program version. See Migrating Legacy Templates on page 5.

[ 5. Review the Considerations for Legacy Files
Before opening a plan or layout file created in a previous version of Chief Architect, be aware of potential changes to

the file that could occur in the new program version. See Considerations for Legacy Files on page 5.

[1 6. Launch Chief Architect X16

Once you have learned about the new features in Version X16 and decided whether to migrate any custom settings from a
legacy program version, launch Chief Architect X16. The first time you launch, the Migrate Settings dialog will give you
the opportunity to bring legacy settings and content forward into Version X16.
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Migrating Legacy Content

Legacy users of Chief Architect Premier often have a wealth of library catalogs and other custom content that they have
built over time and want to continue using.

LEGACY LIBRARY CONTENT
There are several ways that legacy library catalogs can be brought into Chief Architect X16.

If you have Chief Architect version X5 through X15 installed on your computer, the Migrate Settings dialog will display
after you activate the license, allowing you to migrate library content as well as a selection of other settings for use in Chief
Architect X16. If multiple legacy versions are present on the system, only the data associated with the most recent will be
migrated.

You can import library files from Versions X1 through X5 at any time by selecting Library> Import Library (.calib,
.calibz) from the program menu.

CusTOM GRAPHICS FILES

Chief Architect can use graphics files regardless of where they are stored on your system; however, it is a good idea to keep
your data organized in one location. If you have custom graphics files, including textures, images or backdrops that you
used in a previous program version, you can copy them manually using your operating system for use in Chief Architect
X16.

¢ Copy custom texture files to the Chief Architect X16 Textures folder located in the Chief Architect X16 Data folder.

¢ Copy custom image files to your Chief Architect X16 Images folder located in the Chief Architect X16 Data folder.

e Copy custom backdrop files to your Chief Architect X16 Backdrops folder located in the Chief Architect X16 Data
folder.

In Chief Architect X1 through X15, custom graphics were saved in the Chief Architect Data folder, as they are in version
X16. In version 10, they were located in the program’s installation directory, in folders that began with “My”. Custom
backdrops, for example, were saved in “My Backdrops”.

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image objects,
however, which are stored in the library so it is important to retain them. There are several tools available for adding
materials and images to the library.

Migrating Legacy Settings
The Migrate Settings dialog lets you migrate settings from the most recent legacy installation of your Chief Architect title
into Version X16. If you have extensively customized your Preferences, Toolbars, or Hotkeys, you may want to continue

using those settings. Before doing so, though, it is important to consider that you may make it harder to take advantage of
new tools and functionality in Version X16.

PREFERENCES SETTINGS

Although you can migrate your Preferences settings from Versions X5 through X15 into Version X16, the settings that are
available in Version X16 may differ from previous program versions. You should review all the settings in the Preferences
dialog to make sure that they are set to suit your drawing needs.
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CUSTOM TOOLBAR CONFIGURATIONS

It is possible to migrate toolbar configuration files from previous program versions into Version X16; however, it is also
possible that your migrated toolbars will be missing new tools available in Version X16.

Additionally, obsolete toolbar buttons are occasionally removed from the program and will also be removed from migrated
legacy toolbars. See New and Improved Features by Chapter on page 13 for information about new features as well as
removed or deprecated tools.

CuSTOM HOTKEYS

Like toolbar configurations, legacy hotkeys can be migrated into Chief Architect Premier X16. Bear in mind, though, that
occasionally the default hotkeys are modified to accommodate new features or changes in default system hotkeys.

Migrating Legacy Templates
Chief Architect X16 installs a selection of template plan and layout files that have been set up to take advantage of the

program’s updated tools and features. Although you can migrate your template files for use in Version X16, for best results
it is recommended that you either:

e Use the installed templates when creating new plans and layout files in Chief Architect X16

* Use the installed templates as the basis for creating new custom templates.

If you choose to continue using template files that you used in a previous program version, it is very important that you take
the time to review all the default settings in the file, making sure that they will continue to suit your needs in Version X16.
See New and Improved Features by Chapter on page 13.

Next, make sure that you are aware of changes in Version X16 that may affect legacy files: including templates. See
Considerations for Legacy Files on page 5.

When you are ready to proceed, make copies of your custom templates in the Chief Architect X16 Templates directory. The
Templates directory is located in the Chief Architect X16 Data folder. Next, open each template as you would a regular plan
or layout file, by selecting File> Open, and then save any changes you make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from the same
program version, as well. As with a template plan, take the time to go through the layout template’s defaults and make sure
they are suited for use in Version X16 and that their line weight scales do not conflict with those in your template plans.

Considerations for Legacy Files

As in all software, every new program version introduces changes to its functionality as well as to the user interface. If you
choose to bring a project forward, be sure to take a few moments to look it over in the new version and confirm that the new
functionality does not require you to make any modifications. Particularly if you have an approaching deadline, you may
find it best to finish the current project in the version of the software in which you began it.

. Be sure to read this section before opening any plans created in
A carlier versions of Chief Architect.

Chief Architect X16 can open the .plan and .layout files from prior versions. Files with the older .pl and .la file extensions

are no longer supported, however, and cannot be opened by Chief Architect X16. Before opening any files created in earlier
versions of Chief Architect, it is important to be aware of changes made in the newest version and the effect they may have
on your legacy plan and layout files.
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Please note that files saved in the latest program version cannot be read by older versions of the software. When a legacy
file is saved in the version X16, an unaltered copy of the original file is created in the Chief Architect X16 Data folder,
under Archives, which can still be opened in the original version.

FOR FILES CREATED IN VERSION X15 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X15 or prior, bear in
mind the following:

1. GPU Ray Trace Samples
In Chief Architect X16, GPU ray tracing is performed using path tracing, which requires more samples than in previous
versions but produces more accurate lighting effects more efficiently. When a legacy file from Version X15 is opened in
Version X16, the Maximum Samples value is multiplied by 10. When a legacy file from Version X14 or prior is opened
in Version X16, Maximum Samples is set at 2000.

2. Door Thickness
In Chief Architect X15 and prior, the Thickness value set in the Door Specification dialog affected parametric door
panels in 3D views but not door symbols. In Version X16, this setting affects both types of door panel in 3D. When a
legacy file is opened in Version X16, any symbol door panels will have the depth specified in the Door Specification
dialog when viewed in a camera view rather than the depth of the symbol object.

3. Material Emissivity

In Chief Architect X15 and prior, the Emissive property for materials could be set using decimal values. In Version X16,
this setting supports whole numbers only. When a legacy file is opened in Version X16, any decimal Emissive values
will be rounded to the nearest whole number. If this setting is rounded to zero, the change may be noticeable in
Standard, Duotone, and Watercolor renderings.

FOR FILES CREATED IN VERSION X14 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X14 or prior, bear in
mind the following:

1. Window Casing Reveal

In Chief Architect X14 and prior, window casing had an Overlap Frame setting that controlled where casing was placed
relative to the window frame, and windows with different frame Width values for their top, bottom, and sides would also
have different reveals. In Version X15, this setting was replaced with a Reveal setting. When a legacy file is opened in
Version X16, any windows with different Width values will no longer have different reveals.

2. Text Indent and Margins

In Chief Architect X14 and prior, the indent and margins of text could vary depending on the font used. In Version X15,
indent and margins are not affected by settings in the font. When a legacy file is opened in Version X16, text with
varying indent and/or margins may be affected.

FOR FILES CREATED IN VERSION X13 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X13 or prior, bear in
mind the following:
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1. Stair Walklines
In Chief Architect X13 and prior, Walklines were drawn on the "Dimensions" layer. In Version X14, they are drawn on
the same layer as the staircase. When a legacy file is opened in Version X16, any Walklines displaying in the file may
have different line color, weight, and style attributes.

2. Door Rough Openings
In Chief Architect X13 and prior, if a door's Floor to Bottom height was not sufficient to accommodate its Bottom
Rough Opening, the door's Top Rough Opening space would be increased in the model but not in the Door Specification
dialog. In Version X14, this no longer occurs: if the Floor to Bottom height is less than the Bottom Rough Opening, the
full Bottom Rough Opening is simply not modeled when framing is generated. When a legacy file is opened in Version
X16, its rough opening is modeled exactly as it was in the previous program version but its Top and Bottom Rough
Opening values now reflect how the rough opening is modeled.

3. NKBA Auto Dimensions
In Chief Architect X13 and prior, the NKBA Auto Dimension and NKBA Auto Elevation Dimension tools had restricted
default settings that met drawing standards set by the National Kitchen and Bath Association. In order to allow greater
flexibility in Version X16, these tools have been merged into the other Auto Dimension tools. In plan files created using
a template installed with Version X16, NKBA compliant dimensions can be created using the "Kitchen and Bath
Dimension Defaults". In legacy plans opened in Version X16, use the "Legacy NKBA Dimension Defaults".

FOR FILES CREATED IN VERSION X12 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X12 or prior, bear in

mind the following:

1. Default 110V Ceiling Outlet
In Chief Architect X12 and prior, the 110V Outlet tool did not have the ability to place outlets in ceilings. In Version
X13, this ability was added, as was the new GFCI Outlet tool. When a legacy file is opened in Version X16, the new
Electrical Defaults settings for these items will automatically refer to objects in the Version X16 Core Catalogs. You
should confirm that these defaults meet your needs. If these default objects are not present in your library, a warning

message will inform you of the issue.

2. Sliding Door Hinge Side
In Chief Architect X12 and prior, the fixed or 'hinge' side of sliding doors was described as viewed from the exterior
side of the door. In Version X13, the hinge side is described using the more common method: as viewed from the
interior side. When a legacy file is opened in Version X16, all instances of the %hinge_side% Name-Value Pair in
labels, schedules, and the Materials List will use the new method. You should confirm that the Hinge Side information
in labels, schedules, and Materials Lists meets your needs.

3. Automatic and Manual Dimension Layers
In Chief Architect X12 and prior, the system default layer for automatically generated dimension lines was "Dimensions,
Automatic", and the system default for manually drawn dimensions was "Dimensions, Manual". In Version X16, the
system default layer for all dimensions is simply "Dimensions". When a legacy file is opened in Version X16, automatic
dimensions that were on the "Dimensions, Automatic" layer in the earlier version will be placed on the "Dimensions,
Legacy" layer while any dimensions that were on the "Dimensions, Manual" layer in the previous version will be placed

on the "Dimensions" layer.

4. Gable Lines
In Chief Architect X12 and prior, Gable Lines with a Pitch value of 90° were allowed but did not affect automatic roof
generation. In Version X16, they are not supported. When a legacy file is opened in Version X16, any Gable Lines with
a Pitch of 90° will be removed automatically. This will not affect the current roof or automatic roof generation.
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FOR FILES CREATED IN VERSION X11 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X11 or prior, bear in
mind the following:

1. Perspective Crop Mode
In Chief Architect X8 through X11, Perspective Crop Mode allowed older functionality governing zooming in cameras
from Version X7 and prior to be preserved in saved cameras in legacy plans migrated forward. This deprecated tool has
been removed from the program’s menu and toolbars in Version X12, although it can be migrated with legacy toolbars
and hotkeys. Saved cameras in legacy plans with this behavior enabled may become distorted if you pan or zoom in the
view. To permanently disable this behavior in a camera view and resolve the resulting distortion, select Window> Fill
Window or press the F6 key.

2. Layout Layer Sets
In Chief Architect X11 and prior, the Send to Layout dialog had a sticky Make Copy of Active Layer Set option that
created a new layer set for the layout view to help preserve layer settings in that view. This option was removed in
Version X12 to encourage use of the multiple saved plan views. Saved plan views did not exist in Version X9 and prior,
however, so if you open a plan originally created in Version X9 or prior, extra care must be taken to make sure layout
views do not use the same layer set.

3. Materials List Formulas and Ruby Macros
Name-Value Pairs returned length, area, and volume measurements as Floats. In Version X12, these values are reported
using the Measurement class that includes both a numeric value and a unit. Older Ruby code may change behavior when
migrated into Version X12. When a legacy Ruby macro or materials list formula is evaluated, the program will
automatically check its version and prompt you to migrate it to the newest version.

4. Units of Measurement
In Chief Architect X11 and prior, units of measurement used by the program, including user-defined units, were stored
in a file called Units.dat located in the Chief Architect Data folder. Beginning in version X12, this information is saved
with other Preferences settings.

FOR FILES CREATED IN VERSION X10 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X10 or prior, bear in
mind the following:

1. Marker and Elevation Point Heights

In Chief Architect X10 and prior, the # sign could be added to the label of a Marker or Elevation Point and the label
would report the height of the Marker or the Elevation Point’s elevation. In Version X16, text macros are used to report
this information instead. In legacy plans, any # signs in Marker or Elevation Point labels will be replaced by the
%heightf% or %elevationf% macro.

2. Glass Shower Walls
In Chief Architect X10 and prior, the “Glass Shower” wall type was included in installed template files and like other
wall types, built to the structural layer of floors and ceilings and to the Main Layer of adjacent walls. In Version X16,
this wall type has the new Partition Wall attribute and instead builds to floor, ceiling, and wall surfaces. When a legacy
file is opened in Version X16, this wall type will be modified to have Partition Wall checked automatically and existing
walls will be affected by this change.

3. Fixture Schedules
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In Chief Architect X10 and prior, 3D Elevations and Perspectives in Fixture Schedules showed cabinet fixtures inserted
into a cabinet. In Version X16, fixtures are shown on their own, even when they are inserted into an object in the plan.
When a legacy file is opened in Version X16, any fixture schedules showing 3D views of objects may be affected by
this change.

FOR FILES CREATED IN VERSION X9 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X9 or prior, bear in
mind the following:

1. Parallel Lights

In Chief Architect X9 and prior, Parallel Light sources could be specified for electrical light fixtures and Added Lights.
In Version X16, Parallel Lights are no longer supported. In legacy plans opened in Version X16, any Parallel Light
sources will be converted to Spot Lights.

2. Brick Ledges

In Chief Architect X9 and prior, brick ledges were not represented in plan view. In Version X16, brick ledges are drawn
in plan view on the “Slabs” layer in stem wall and grade beam foundations, and on the “Walls, Foundation” layer in
monolithic slab foundations. When a legacy file is opened in Version X16, brick ledges, if present, will be drawn.

3. Window Types

In Chief Architect X9 and prior, the %type% text macro for windows reported some Window Types using abbreviations.
In Version X16, the abbreviations were replaced with full words. When a legacy file is opened in Version X16, the
width of Window Schedules may be affected, as may the width of columns in saved Materials Lists.

4. Joist Direction Lines

In Chief Architect X9 and prior, Joist Direction Lines described all platform framing as “joists” and used nominal
lumber sizes in whole inches in US Unit plans. In Version X16, the platform’s framing Structure Type is reported and in
US Unit plans, the size is described in fractional inches. When a legacy file is opened in Version X16, Joist Direction
Lines will use the new, more accurate labeling.

5. Custom Schedule Columns

In Chief Architect X9 and prior, custom schedule columns could be created by adding a Sub Category to a type of object
on the Categories panel of the Preferences dialog. In Version X16, Sub Categories can no longer be created in this
manner. When a legacy file is opened in Version X16, any Sub Categories shown as custom schedule columns will be
converted to Custom Fields.

6. Registered User Text Macros

In Chief Architect X9 and prior, a selection of Registered User Text Macros could be inserted into Texts, Callouts, and
Markers. These macros no longer displayed any data and in Version X16, they are no longer recognized. When a legacy
file is opened in Version X16, any Registered User macros inserted into text objects are treated as regular text.

FOR FILES CREATED IN VERSION X8 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X8 or prior, bear in
mind the following:

1. Layer Names

In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it possible to assign different
names to the same layer in different layer sets. In Version X9, this option was no longer supported. When a legacy file is
opened in X16, the layer names used in the currently active layer set will be retained and any other layer names in other
layer sets will be discarded.
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FOR FILES CREATED IN VERSION X7 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X7 or prior, bear in
mind the following:

1. Boxed Eaves
In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they extend into exterior rooms with
“Use Soffit Surface for Ceiling” specified when located between the roof baseline and an interior room. In some legacy
plans opened in Version X16, the Length value for Boxed Eaves may need to be modified in the Roof Plane
Specification dialog.

2. Uppercase Text

The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and prior, it was an option for
Room Labels and Schedules only. In legacy plans opened in Version X8, any Schedules present in the drawing will be
assigned a Custom Text Style, as will their associated Schedule Defaults. If any Schedule Default is set to Use Layer for
Text Style and no objects are present on that layer, a new Schedule Text Style will be created and assigned to that layer.
Room Labels are treated similarly: if any are present, they and their defaults will use a Custom Text Style. If a given
Room Label or Schedule has been sent to layout more than once and was set to use different Text Styles in each layout
view, it is possible that its appearance may be affected in some views.

FOR FILES CREATED IN VERSION X6 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X6 or prior, bear in
mind the following:
1. Built-in Appliances
In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base cabinets had incorrect sizing
data. In legacy plans opened in Version X16, these appliances will not fit into the cabinet correctly and will need to be
replaced. Built-in dishwashers are particularly affected.
2. Formatting of Bulleted and Numbered Lists
In Version X7, various improvements were made to the way lines of Rich Text are spaced. In legacy plans opened in
Version X7, Rich Text objects with bulleted and numbered lists may require adjustments.
3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing. The change in spacing
may increase the overall height of text objects using this font in X6 files opened in Version X16. X5 and prior legacy
files will not be affected by this change.

FOR FILES CREATED IN VERSION X5 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version XS5 or prior, bear in
mind the following:

1. Name-Value Pairs for Doors and Windows

In Version X6, the NVPs door_style name, door_type name, and window_type name were shortened to style name and
type name. Any object labels or text macros using these NVPs in legacy plans opened in Version X16 will need to be
replaced.

10
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FOR FILES CREATED IN VERSION X4 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or prior, bear in
mind the following:

1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in Version X5
and later, they are measured to the outside of the fascia or shadow boards, if present. In legacy plans opened in Version
X16, this will not affect the appearance of roof planes in floor plan view because in X4 and prior, roof plane polylines
represented the projected framing area whereas in Version X16 they represent the total projected area. But, the position
of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward displayed the interior material on the exterior side of
the door. This was corrected in Version X16. Doors modified to work around the old behavior could be affected in
legacy plans opened in Version X16.

3. Door Swing Direction and Louvers

Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not wrapped. In
legacy plans opened in Version X16, the extents of wrapped lintels and sills will be adjusted so that they equal their
Extend setting.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert into
cabinets effectively. In Version X16, the offset is set in the Cabinet Specification dialogs. When legacy plans are opened
in Version X16, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if one exists. Any customized
or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views
If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, then
those objects’ labels will display in that view when the plan is opened in Version X16.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible in rendered
views even when their Index of Refraction was set to 1.0. When legacy plans are opened in Version X16, Transparent
materials with an Index of Refraction of 1.0 are transferred to the General Material class and assigned a Transparency
value of 100%. This will not affect these materials’ appearance in ray trace views, but will make them completely
invisible in rendered views.

8. Registered User Text Macros

In Chief Architect X4 and prior, a selection of Registered User Text Macros could be inserted into Texts, Callouts, and
Markers. These macros reported information that was provided when the program was installed and registered on the
computer. In Version X5 and later, the program no longer collects registered user information. When a legacy file is
opened in Version X16, any Registered User macros inserted into text objects are treated as regular text.

9. Invisible Beams

The legacy Invisible Beam check box was removed from the Wall Specification dialog. When legacy plans are opened
in Version X16, any Invisible Beam walls will be converted to Invisible Walls.

11
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FOR FILES CREATED IN VERSION X3 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or prior, bear in
mind the following:

1. Text Styles
The appearance of a number of objects that include text - including object labels, the North Pointer, Sun Angles, Joist
Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text Style. Their appearance
may be altered somewhat in legacy plans opened in Chief Architect X16.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect X16. Lighting in legacy
plans may appear noticeably brighter when viewed in version X16.

FOR FILES CREATED IN VERSION X2 AND PRIOR

If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file management
changes and structural enhancements:

1. Legacy file formats

Chief Architect9.5 and prior files were saved in .pl and .la the file formats. These file formats files are no longer
supported and cannot be opened in version X16.

2. Material textures, images, and backdrops

Chief ArchitectX?2 and prior installed with a catalog of library content, including a selection of material textures, images,
and backdrops. This library catalog is no longer installed with the program because it is now available for download on-
demand, so it will be possible to open a legacy plan in version X16 and encounter numerous missing file warnings. To
avoid this, we recommend using the Export Entire Plan feature in the original program version to create a folder that
includes the plan and all associated textures, images, and backdrops before opening this file in X16. This tool is renamed
Backup Entire Plan in version X16.

3. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as railings,
stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the subfloor. These
objects now measure their Floor to Bottom height from the floor finish surface by default, so it is possible that you may
notice height changes for these objects - particularly in saved, annotated cross section/elevation views.

4. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) in
version X2 and prior to 6 3/4” (169 mm) in Chief Architect X16. This may affect the riser heights of stairs, as well as
the thicknesses of landings attached to those stairs.

5. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height check box. If a cabinet,
fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or prior and was
located in a room with a floor height other than the default for the current floor, then the object’s Floor to Bottom
Height will change to equal that room’s floor height. The object’s position in the model will not change, however.

6. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file is
opened in version X16 and these wall types are detected, they are replaced by an updated, non-generic wall type.

12
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Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side. Railings that define a
Deck room with Advanced Deck Framing Built will not acquire sheetrock layers.

7. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers of
sheetrock when the plan is opened in version X16. This can affect the appearance of staircases where they join to a floor
platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top edge of the staircase.

8. Deck rooms
In legacy plans opened in Chief Architect X16, Deck rooms with Advanced Deck Framing built retain the framing but
have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built are converted to
Balcony rooms.

9. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The Ambient
setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when opened in version
X16.

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans is
capped at 4” (100 mm).

10. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X16, Materials Lists are set to calculate
Total Linear Length. For a combination of linear length and piece count, select Mixed Reporting in the Structural
Member Reporting dialog.

11. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X16 it applies to the
entire plan. As a result, it is turned off by default in legacy plans opened in version X16.

New and Improved Features by Chapter

The following is a list of new and improved features in Premier Version X16. Where possible, cross-references to additional
information are provided.

PROGRAM OVERVIEW

« New Tool Search & can be added to the toolbars and used to access any tool.

FILE MANAGEMENT

e New Clear File Reference option for materials in the Missing Files dialog.

PROJECT PLANNING

¢ New automatic Construction Line Order Management options.
¢ Construction Lines now have the Reverse Direction edit tool.

e Space Planning Room Boxes can now be drawn by clicking and dragging and can be edited to any shape.
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o New Remove Overlapped Areas and Overlap Adjacent Room Box edit tools for Space Planning Room

Boxes.
e Space Planning Room Boxes now display lines representing wall width.

* New Find Objects on Layer(s) option in the Active Layer Display Options side window.

PREFERENCES AND DEFAULT SETTINGS

¢ New Blurred Backdrop Effect Preferences option for material previews.
e The Minimum Display Size for Dimensions now only affects Temporary Dimensions.
¢ The obsolete Optimize for Multi-Core CPUs troubleshooting setting has been removed from the Preferences dialog.

e The obsolete Hardware Edge Smoothing setting has been removed from the Preferences dialog. High quality anti-
aliasing is always used.

TOOLBARS AND HOTKEYS

¢ Toolbars can now be added for when No View is open.

CREATING OBJECTS

e The frame, casing, and sill of doors and windows can now be snapped to.

DISPLAYING OBJECTS
e A variety of edit tools including Make Parallel/Perpendicular and Reflect About Object can now use angled editing
axes defined the corners where object edges meet.
* New Poché fill option in plan views, sections, and cameras.

e New Use Default Layer option in the Select Layer dialog lets you assign objects to their system default layer using
the Layer Painter.

e Layers can now be managed and their attributes edited in the Select Layer dialog.

e Layer management options are now available in the contextual menu for layers in the Active Layer Display Options
side window.

* New Merge option in the Line Style Specification dialog.
e Fill styles from the Library now have separate X and Y Scale settings.

EDITING OBJECTS

* New Action History side window lets you access all recent Undo actions.

e The Convert Polyline dialog now features a scrollable list.

e New Retain Original Polyline option in the Convert Polyline dialog.

e Plain Polyline is now an option in the Convert Polyline dialog.

¢ The obsolete Convert to Plain Polyline edit tool has been removed.

e Terrain Walls and Terrain Curbs are now options in the Convert Polyline dialog.

« New Concentric Resize /4 and Set Concentric Jump /% edit buttons.

e Exterior Sprinklers are now deleted with Terrain Objects using the Delete Objects dialog.
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CAD OBJECTS
e The Select Next Object, Delete, Point to Point Move, and Center Object edit tools are now available for CAD Block
Insertion Points.
e CAD Details can now be copied and pasted into different files.
e Labels can now be assigned to Revision Clouds.
« New Hide Selected Edge X7 and Hide Selected Edge #7 edit tools for CAD polylines.

WALLS, RAILINGS, AND FENCING

¢ Individual wall layers in a Wall Type Definition can now be placed on their own custom layers for display purposes.
¢ New Spacing options for railing newels: "Automatic", "From Start", "From End", "Centered".
« New Move Newels }#, Add Newel §, Delete Newel X |, and Reset Newels 1 edit tools for customizing newel

post layout.
e Offset double newel posts at exterior railing corners can now be created.
¢ Chamfered footings for foundation stem walls can now be specified.

e The defaults for multiple wall tools can now be edited as a group via the Default Settings dialog.

RooMS

e The OBJECT INFORMATION panel is now available in the Room Specification and Floor Defaults dialogs.
e New Deck Beam Count, Position, and Offset from Deck Edge settings.
e New Deck Post Alignment with Deck Beams settings.

¢ New Room Information in the Room Specification dialog reports size information about the selected room(s).

DIMENSIONS

¢ Dimension lines can now be created and edited in 3D camera views.

« New Delete Dimensions X tool lets you delete all dimensions in the current view.

* New Leader Line options for dimension labels offset from their default location due to length.

¢ If you double-click any of the Dimension Tools child buttons to open the Dimension Defaults dialog, the LOCATE
panel associated with that tool will be active.

¢ The maximum Line Separation value in the Dimension Defaults dialog has been increased to 500" (12500 mm).

e Auto Story Pole Dimensions now allow multiple marks at the same location in the model.

TEXT, CALLOUTS, AND MARKERS
e New Pointed capsule Callout and Note shape.
« New Convert Text to Note “® edit tool for Rich Text and Text objects.
o Schedules created using the Create Note Schedule from Note(s) edit tool now include the Note Type in their

Title provided that the selected Notes have the same type.

* New Auto Adjust Height in Plan View option for Notes can be unchecked to prevent their Z Position from changing
when they are moved in plan view.
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DOORS AND WINDOWS

All Door Types can now be placed in railings and fencing.

A Sill or Threshold for both doors and windows can now be specified.

Doors can now have separate materials assigned to the threshold and interior/exterior jamb.
Windows can now have separate materials assigned to the threshold and interior/exterior frame.
The Panel Offset for all Door Types can now be set in the Door Specification dialog.

The default Window Level is now 0 and can no longer be modified.

CABINETS

The Thickness of cabinet door and drawer fronts can now be specified.
New Diagonal and L-Shaped Corner Type options for Shelves and Partitions.

The Panel Thickness setting now affects panel symbols from the Library as well as parametric panels.

ELECTRICAL

New Electrical Connection Defaults dialog.
Electrical Connection Splines can now attach to cabinets and non-Electrical symbol objects.

Electrical Connection Splines are no longer required to attach to objects and can snap to points on objects that they are
not attached to.

New Reset Curvature o edit tool for Electrical Connection splines.

When an Electrical object is selected and an Electrical Connection spline is attached to it, the "Electrical,
Connections" layer is listed in the Object Layer Properties dialog and Active Layer Display Options side window.

SCHEDULES AND OBJECT LABELS

The Add to Library {I+ edit tool is now available for schedules.

Objects from multiple rooms on a selected floor level can now be listed in schedules.

New Columns/Rows panel in the Schedule Specification dialog.

Schedules can now be added to the library.

New Pointed capsule schedule callout shape.

New Calculate Total option produces a calculation in the Totals row for selected columns.

New Sum Similar Rows option groups similar objects in a single row and reports the total count, length, area, or
volume for all objects associated with that row.

The new Calculate Total option for columns in the Schedule Specification dialog.
The obsolete Total Length column in schedules has been removed.
Schedule text now can be aligned Vertically within rows as well as horizontally within columns.

The Move Up in Schedule and Move Down in Schedule edit tools are now available when Use Label is the selected
schedule label option.

New Find Schedule(s) from Object &g edit tool located schedules that list a selected object.

New Reset Column Widths edit tool for schedules as well as simple Text with tab spacing.
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STAIRS, RAMPS, AND LANDINGS

Stairs and Ramps can now be added to the Library.

New Multiple Stairs and Ramps shared specification and defaults dialogs.

ROOFS

Ceiling Planes can now be listed in schedules.
New Include Ridge framing option in the Dormer Specification dialog.
The Ridge Depth of dormer ridge and hip rafters can now be specified in the Dormer Specification dialog.

When a roof plane's Baseline is selected in plan view, the entire roof plane is now highlighted.

FRAMING AND TRUSSES

Framing Types are now customizable.
New Build All Framing @ tool.

All build framing commands are organized in a new, streamlined Build Framing dialog.
Floor and Ceiling Framing can now be generated separately.

New Girder Truss Line = tool lets you specify the location of automatically generated girder trusses.
New Roof Truss Direction Line I tool lets you specify the direction of automatically generated roof trusses.

Automatically-generated End Trusses can now include horizontal blocking.
New Flat Header Framing Method in the Door and Window Specification dialogs.
New Build Framing for Parent Object(s) B2 edit tool allows you to build or rebuild the framing for the parent

object of a selected framing member.

The View Wall Detail from Exterior option can now be specified in the Wall Defaults dialogs and on a wall by wall
basis.

Blocking can now be added to trusses.

TRIM AND MOLDINGS

The 2D and 3D Molding Line/Polyline tools have been merged.

New Select Edit Plane &5 edit tool for Molding Polylines in camera views.

New Miter Molding at Twisted Ends and Miter Molding If Next Edge Turned Off options in the Molding Polyline
Specification dialog.

All Molding Polylines can now display labels.
The Fillet and Chamfer edit tools are now available for Molding Polylines.

THE LIBRARY

The Convert Legacy (.alb) Library Files tool has been retired.

The Adjust Lights dialog is now accessible for a selected light fixture in the User Catalog using the contextual menu.
New Molding is 3D library search attribute in the Advanced Search dialog.

The Move to Folder(s) dialog has been renamed Add Link.
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SYMBOL OBJECTS

Under-cabinet fixtures can now be placed above a free-standing fixture without selecting it.
The Parametric Display Types available for Image objects can now be assigned to symbol objects.

A symbol's 2D Symbol can now be specified as it is being imported.

OTHER OBJECTS

New Defaults dialogs for Distribution Region and Paths.

New Auto Spacing option in the Distribution Paths and Regions Specification dialogs sets spacing based on the
object's size.

3D Solids can now be included in schedules.
3D Solids now have the OBJECT INFORMATION panel in their specification dialogs.
New Diagonal and L-Shaped Corner Type options for Soffits.

MATERIALS

A material's Roughness Map can now be inverted in the Define Material dialog.
Opacity, Translucency, Transmission Color, and Transmission Roughness Maps can now be assigned to materials.

New Material Class Mix settings allow metal, translucent, and transparent maps to be assigned to the same General
type material.

A Clear Coat can now be applied to a material in the Define Material dialog.
New Thin option in the Define Material dialog renders a material as thin surface rather than a solid mass.

The Preview pane in the Library Browser and the Define Material, Select Material and Plan Material dialogs can now
show a backdrop image instead of the default room.

Stretch to Fit can now be applied to material texture height and width independently.

Translucent materials are now supported in GPU Ray Tracing.

The Reflection color for Shiny Metal and Mirror materials can now be specified for non-ray traced views.
The Emissivity setting is now available for Translucent and Transparent materials.

New pre-defined "Air" Index of Refraction for Transparent materials for ray traced views.

3D VIEWS

New Reset Saved Camera (All) ©) and Reset Saved Camera (Position) % tools.

The CAD polylines created by the Auto Detail tool are now placed on the same layer as the structural component they
are associated with.

An arrow can now be specified for the end of a cross section/elevation camera symbol's clip plane line.
The Cross Section Slider tool is now available in Vector Views.

Changes to the settings in the Camera and Cross Section/Elevation Specification dialogs made while the camera view
is active are not permanent unless you explicitly save the view.

The obsolete Edge Smoothing When Idle setting for 3D views has been removed from the program.
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3D RENDERING AND RAY TRACING

GPU ray tracing is now performed using path tracing, which requires more samples than in previous versions but
produces more accurate lighting effects more efficiently.

GPU ray tracing is now supported on Mac Silicon systems running macOS Sonoma.
New AMD FidelityFX options in the Camera Specification dialogs.

Emissive materials can now emit light from the surfaces they are assigned to in Physically Based and Clay GPU Ray
Traces.

New the Next Rendering Technique &3 and Previous Rendering Technique g tools buttons allow you to cycle

through Rendering Techniques using a single button or hotkey.

New Toggle Hand Drawn Lines on Top & toggle.

New Opaque Bounces and Transmissive/Specular Bounces settings control how many times light bounces off or
passes through materials in GPU Ray Traced views.

New Use Only Backdrop for Lighting option removes Sunlight from a view without switching to nighttime.
The Base Rendering Technique used to render a scene prior to applying Watercolor Effects can now be specified.

New Rotate Spherical Backdrop option in camera views with Spherical Panoramic Backdrops.

New Tone Mapping Operator setting for Physically Based and Clay renderings.
The columns in the Adjust Lights dialog are now customizable.
GPU Ray Traced renderings are now automatically denoised when the Maximum Samples have been run.

The obsolete Refraction, Soft Shadows, Cap Live Samples, and Denoise View settings have been removed from the
Rendering Technique Options for CPU ray traced Physically Based and Clay renderings.

PICTURES, IMAGES, AND WALKTHROUGHS

Physically Based and Clay renderings can now be exported as High Dynamic Range .hdr files.

Perspective High Dynamic Range images can now be used as backdrops, and the .hdr file type is now available in the
Import Backdrop File dialog.

Billboard Images can now display in GPU Ray Traced Physically Based renderings.
The LABEL panel is now available in the Walkthrough Path Defaults dialog.

New Open in Default Image Viewer option for exported pictures.

New Capture View to Clipboard optional toolbar button and hotkey.

IMPORTING AND EXPORTING

New Remember Login option in the Chief Architect Account Login dialog.

The Export 360 Panorama dialog now has an option to Save as Backdrop.

PLANTS AND SPRINKLERS

Separate fill styles can be assigned to a sprinkler's Spray Area and Sprinkler Symbol in plan view.
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MATERIALS LIST

e Framing, Roof, and Foundation line items in the Materials List can now be edited without turning off the associated
Auto Build functionality.

LAYoUuT

e Improved feedback helps identify and fix broken layout links.

e Use of Edge and Pattern Line Defaults in Plot Line views can be enabled or disabled regardless of how the view was
originally sent to layout.

¢ The Update View to Layout message, which lets you choose whether you want to update the Plot Lines view on the
layout page or not when you close the camera view, has been restored to the program.

RUBY IN CHIEF ARCHITECT
e New NVPs for walls.
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